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Create Bookmarks in Adobe Acrobat Reader 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Overview 

Set up bookmarks in Adobe Acrobat Reader. 
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Create Bookmarks in Adobe Acrobat Reader 

Introduction 

Use Adobe Acrobat Reader to create bookmarks in the navigation pane by learning to do 
the following: 

 open bookmarks in navigation pane 
 expand topic headings 
 collapse topic headings 
 navigate topic headings 
 zoom In/Out of pages 
 close bookmark window 
 quick Key Glossary 

Open Bookmarks Navigation Pane 
1. On Menu Bar, click View>Navigation Tabs>Bookmarks. A navigation pane appears. 

 

 

Expand the Topic Headings 

1. Click  beside “PDF Reference” to expand heading. A list of bookmarks appears. 
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Collapse the Topic Headings 

1. Click  beside “PDF Reference” to collapse headings. The list of bookmarks 
disappears. 

 

Navigate Topic Headings 
1. Click on any heading to go to the corresponding page in the document. 

Zoom In/Out of the Bookmarked Pages 

1. Press Ctrl  to zoom into the page. 

2. Press Ctrl  to zoom out of the page. 

Close Bookmark Navigation Pane 

1. Click  to close Navigation Pane. 

 
 

Quick Key Glossary 

Key Function 
Ctrl + Zoom In 

Ctrl - Zoom Out 

Ctrl 0 Sets Page to “Fit Screen” size 

Ctrl 1 Zooms In (30%) 

Ctrl 2 Zooms In (60%) 

Ctrl 3 Reveals Bottom Slide Bar 

F4 Hides Bookmark Navigation Panel 

F8 Reveals Print Task Bar 

F9 Reveals Task Menu Bar 



March 2011 
Technical Writing Portfolio 

6 

Create Screenshots Using FastStone Capture 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Overview 

Create screenshots using FastStone Capture. 
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Create Screenshots Using FastStone Capture 

Introduction 

Use FastStone Screen Capture to create screenshots in the following ways: 
 create a screenshot using capture active window 
 create a screenshot using capture window/object 
 create a screenshot using capture rectangle region 
 create a screenshot using capture freehand region 
 create a screenshot using capture scrolling window 
 create a screenshot using capture full screen 
 crop a selected screenshot 
 copy a selected screenshot 

Create a Screenshot Using Capture Active Window 

1. From task bar, click . Screen reverts to a new window with the screen image 
selection.  

2. Drag + cursor to select detail of image to capture.  

Create a Screenshot Using Capture Window/Object 

1. From task bar, click . Screen reverts to a new window with a red rectangle border 
and a hand cursor/icon. 

2. Move hand within the red rectangle border and click on precise detail of image to 
capture. 

Create a Screenshot Using Capture Rectangle Region 

1. From task bar, click . Screen reverts to a new window with intersecting red lines and 

+ cursor. 

2. Drag intersecting red lines and + cursor to precise detail of image to capture. 

Create a Screenshot Using Capture Freehand Region 

1. From task bar, click . Screen reverts to a new window with a lasso icon. 

2. Drag lasso icon and create organic detail of image to capture. 

Create a Screenshot Using Capture Scrolling Window 

1. From task bar, click . Screen reverts to a new window with a + cursor.  

2. Drag + cursor to precise detail of image to capture. 
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Create a Screenshot Using Capture Full Screen 

1. From task bar, click . Screen reverts to a new window with screen image with a red 
rectangle border and a hand cursor. This scrolls through all the information open on the 
screen.  

2. Move hand within the red rectangle border and click on precise detail of image to 
capture. 

Crop a Selected Screenshot 
1. On task bar, click Crop. This crops the image to a specific size. 

Copy a Cropped Screenshot 
1. On task bar, click Copy. Go to the document to place image. 

2. Right click mouse, and click Paste to place selection in the document. 
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Create Mind Maps and Project Charts Using 
SmartDraw 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Overview 

Use SmartDraw to create mind maps and project charts. 
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Create Mind Maps and Project Charts Using 
SmartDraw 

Introduction 

SmartDraw helps you to visualize your ideas. 

Use SmartDraw to create mind maps in the following ways: 

 create a mind map from the home screen 
 add a topic to your mind map 
 add a subtopic to your mind map 
 move a subtopic from one topic to another 
 move an entire subtopic tree to a new topic 
 demote a topic or subtopic 
 promote a topic or subtopic 
 break large projects into smaller tasks 
 create a project chart from a mind map 
 email your mind map to your team 

Create a Mind Map from the Home Screen 
1. From Home Screen, select Mind Map. 

 

2. Click Main Topic box and type subject of your presentation. 
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Add a Topic to your Mind Map 
1. From the Smart Panel, click Add Topic. 

 

2. Click on topic box and type the name of another topic. 

Add a Subtopic to your Mind Map 
1. From the Smart Panel, click Add Subtopic. 

 

2. Click on topic box and type the name of the subtopic. 

Move a Subtopic from One Topic to Another 
1. Select the subtopic and drag it to another topic. Connector lines are automatically reset 

and reconnected. 

Move an Entire Subtopic Tree to a New Topic 
1. Select a topic box and drag it to a new location under a different topic. All subtopics 

connected to the topic you are moving go along with it. Connector lines are reset and 
reconnected automatically to the next topic. The moved topic adopts the style of the 
related topic. 
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Demote a Topic or Subtopic 
1. Click on topic or subtopic to demote. 

 

2. From Smart Panel, click Demote. Now the topic or subtopic is on a new level. 

Promote a Topic or Subtopic 
1. Click on topic or subtopic to promote. 

 

2. From Smart Panel, click Promote. Now the topic or subtopic is on a new level. 

Break Large Projects into Smaller Tasks 
1. From Home screen, select Mind Map. 

2. Click on central object and type the title of your project. 

3. From the Smart Panel, click Add Topic for each component of project. 

4. From the Smart Panel, click Add Subtopic to add a task to each component of the topic. 
Continue until all tasks of the project are identified. 
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Create a Project Chart from your Mind Map 
1. From the Smart Panel, click View As, and then select Project Chart. This creates a 

chart showing the tasks to complete. 

 

2. Enter start and end dates.  

 

3. Change the duration time of the tasks or adjust the task bar. 

Note: Change tasks if necessary. Any changes made on 
project chart, change on the mind map. 

Email Your Mind Map or Project Chart 

1. Click  on Task Bar.  
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2. Select Email to:, and then click on file to send. 

Note: Tabs at bottom of window allow you to move from 
mind map to project chart view. 

Publish to Sharepoint Server 

1. Click  on Task Bar, and then click Sharepoint.  

 

2. Type Sharepoint Server URL, and then click OK. 
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Build Information Queries in Actuate Query 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Overview 

Use Actuate Query to create information queries.  
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Build Information Queries in Actuate Query 

Introduction 

Actuate Query is a tool that uses Information Objects (a category describing a part of 
your business such as customer, amount, or item) to organize information about your 
company.  

Use Actuate Query to do the following: 

 choose information objects 
 add fields to query 
 sort returned data 
 filter results of returned data 
 select output format 
 create a pie chart 

Choose Information Objects 
1. From Main Page, select object to begin the query.  

 

2. This takes you to the Content tab on the Query Field Selection Page. 

Add Fields to Query 
1. In the Content tab of the Query Field Selection Page, select fields to include in your 

query. 
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2. From Available Columns, click on field(s) of choice.  

3. Then click >, to move selection(s) to Selected Columns box. Use >> to move all column 
options to Selected Columns box. 

Sort Returned Data 
1. In the Sorting tab, click the down arrow at Specify the Sort Order, then click down 

arrow for Ascending or Descending order. A list of data appears.  

 

Filter Results of Returned Data 
1. In the Filters tab, click Predefined Filters (Parameters) drop down menu. 

 

2. Choose Location to filter data by. In this screenshot, the user chooses the Location of NH 
(New Hampshire). Only the data for NH will appear. 

Select Output Format 
1. In the Finish tab, select the format of your output document by clicking on one of the 

following options: 

 

 Browser (DHTML) 
 Excel 
 PDF 
 e-analysis 
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2. Click Excel, and then click Run. 

 

3. The data displays in an Excel spreadsheet. 

  

Create Pie Charts and Pivot Table Formats 
1. In the Finish tab, select e-analysis, and then click Run. 

 

2. The results are in a table format for easy analysis. 
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3. To create a pie chart from the e-analysis spreadsheet, click .  
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Schedule Reports with the HSBC Automated File 
Delivery Tool 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Overview 

Configure the Automated File Delivery Tool for downloading report files to your 

computer. 
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Schedule Reports with the HSBC Automated File 
Delivery Tool 

Introduction 

The HSBC Automated File Delivery tool allows you to schedule reports when you want 
them. 

Configure the Automated File Delivery tool to do the following: 

 set up Automated File Delivery (AFD) 
 create a New Schedule 
 set up a download directory 
 receive reports in bulk or individually 
 schedule frequency of reports 
 generate a report at a specific time 
 generate a recurring report 
 select reports to download 
 view schedule summary 

Set Up Automated File Delivery (AFD) 
1. Contact the System Administrator. 

Create a New Schedule 
1. In file menu, click Create New Schedule – Reports and File Download. 

 

2. The AFD Schedule Maintenance window appears. 
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3. In the Short Name section, type a short name. This is a schedule identifier for quick 
filtering purposes. 

 

4. In the Schedule Name section, type a schedule name. 

Set up a Download Directory 
1. In the Download Directory section, type a directory path. Find your file here. Leave 

space blank to download to the default directory. 

 

Receive Reports in Bulk or Individually 
1. In the Receive Reports section, click either In Bulk or Individually. 

 

Schedule Frequency of Reports 
1. In the Schedule Frequency section, click down arrow, then select from the following 

options: 

 Daily 
 Weekly 
 Monthly (end of month) 

 

Generate a Report at a Specific Time 
1. At Generate Report, click At Specific Time. 

2. In the hh/mm section, enter a specific time to generate a report. 

 

 

Generate a Recurring Report 
1. At Generate Report, click Every to receive a recurring report. 
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2. At the Hours drop down menu, click down arrow to choose specific number of hours for 
report to recur. 

3. At the From and To sections, enter hours to establish the recurring time period. 

4. At the Time Zone drop down menu, click down arrow to choose appropriate time zone. 

Select Reports to Download 
1. At the Report Summary List, select a report. 

 

2. Click , for AFD schedule to take effect. 

3. Once all steps completed, the acknowledgement page appears. 

 

Schedule Summary 
1. Click the Schedule Summary.  

 

Your report summary appears. 

 



March 2011 
Technical Writing Portfolio 

24 

Customize the Internet Options’ Tabs for Internet 
Explorer 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Overview 

Customize the internet options’ tabs for Internet Explorer. 
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Customize the Options’ Tabs for Internet Explorer 

Introduction 

Here is a reference guide of the Options tab under the Tools section of Internet 
Explorer: 
 

Internet Explorer>Tools>Internet Options
Tab Option Function 

General Homepage  customizes home pages 
Browsing History Search  deletes browsing history 
Search  changes default settings 

Security Select a Zone to View or Change 
Security Settings 

 Internet 
 Local 
 Trusted Sites 
 Restricted Sites 

Security Level for Zone  Appropriate for most sites 
 Prompts before downloading 

unsafe content 
 Unsigned Active X controls will 

not be loaded 
Privacy Settings  Blocks third party cookies 

Pop-Up Blocker  Prevents most pop-up windows 
In-Private  Allows/disallows collection of 

data for In-Private Browsing 
Content Content Advisor  Ratings to help control internet 

content 
Certificates  Encrypts connections and 

identifications 
Auto Complete  Stores previous web page 

searches and suggests matches  
Feeds and Web Slices  Creates automatic feeds and web 

slices for pages used frequently 
Connections Setup an Internet Connection  Sets up an internet connection 

Dial-up and Virtual Private Network 
Settings 

 Adds dial up connection 
 Adds VPN connection 

Choose Settings for Proxy Server  Allows for setup of proxy server 
LAN Settings  Sets up local area network 

connections 
Programs Default Web Browser  Sets Explorer as default browser 

Manage Add ons  Enables or disables browser add-
ons 

HTML Editing  Chooses program Explorer to use 
to edit HTML files 

Internet Programs  Chooses email program 
Advanced Settings  Sets accessibility for windows 

and tabs 
Browsing  Notifies about script errors 
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General Tab Task-Oriented Procedures 

The Internet Options dialogue window allows you to do the following: 
 create Home page tabs 
 set or delete browsing history 
 change search defaults 
 change how web pages are displayed in tabs 
 change appearance of web pages 

Create Home Page Tabs 
1. In the General tab, type name of URL address in Home Page box. 

 

Set or Delete Browsing History 
1. Click Settings, to select from the following: 
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Change Search Defaults 
1. Under Browsing History, click Settings to change default search settings. 

 

Change How Web Pages Display 
1. Under Tabs, click Settings to change how web page display. 

 

Change Appearance of Web Pages 
1. Under Appearance, click the following:  

 
 Colors - change display colors of page. 
 Languages - change to preferred language. 
 Fonts - choose font style. 
 Accessibility - ignore set formatting styles. 
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Manage the Windows System Properties Dialogue 
Box 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Overview 

Manage the Windows System Properties Dialogue Box. 
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Manage the Windows System Properties Dialogue 
Box 

Introduction 

Here is a reference guide for the Windows Systems Properties dialogue box: 
 

Windows/Systems Properties/Change Settings 
Tab Option Function 
Computer Name Computer Description  Identifies computer on network 

Network ID 
 

 Creates identity of computer to join 
domain or workgroup 

Change 
 

 renames computer or changes 
domain or workgroup 

Hardware Device Manager  lists hardware installed on computer 
and allows property changes to 
devices 

Device Installation Settings  allows for Windows to download 
drivers for software and provides 
details about drivers 

Advanced Settings 
(Changed by 
Administrator) 

Performance  adjusts visual effects, processor 
scheduling, memory usage and 
virtual memory 

User Profiles  changes settings related to user 
login 

Startup and Recovery  customizes startup features  
 handles system failure and 

debugging problems  
Environment Variables  adjusts desktop environment 

System Protection System Restore  restores computer back to previous 
version after unwanted changes 
occur 

Protection Settings  allows for protection of drives 
Configure  system administrator disables 
Create  system administrator disables 

restore point creation 
Remote Remote Assistance  allows remote assistance to 

computer 
Remote Desktop  allows select users to gain access to 

the computer 

Change Settings Options 

In the Windows System Properties> Change Settings dialogue box you have the 
following options: 

 create a name for your computer 
 join a domain or workgroup 
 rename your computer or change its domain name 
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Create a Name for Your Computer 
1. In the Computer Name tab, type the name of your computer in Computer Description.  

 

Tip: follow the example for possible computer names. 

Join a Domain or Workgroup 
1. To join a domain or workgroup, click Network ID. 

 
 

2. In the Join a Domain or Workgroup window, select an option that applies to your 
computer and click Next. 

3. In the next Join a Domain or Workgroup window, select the answer that best applies to 
your company network domain and click Next.  

4. In the next Join a Domain or Workgroup window, type user name, password and 
domain name and click OK. 
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Rename Your Computer or Change its Domain Name 
1. To rename your computer or change its domain name, click Change. 

 
2. In the Computer Name/Domain Changes window, type Computer name. 
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3. Click More, to add Primary DNS suffix of this computer and Net BIOS computer 
name. Click OK. 

 

4. Select member of Domain or Workgroup, and add applicable name. Click OK. 
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Import and View an XML File in the PADGen Program 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 

Overview 

Use the PADGen software program to import and view an XML file. 
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Import and View an XML file in the PADGen Program 

Introduction 

Learn how to import and view XML files in the PADGen software program. 

Here is a reference guide for the main window of PADGen: 
 
 
 

PADGen Main Window 
Tab Function 

Company Info  describes contact information about the company 
profiled 

Program Info  describes information about program used (i.e. Flash 
Media Player) 

 describes language 
 describes operating systems supported by 

Descriptions  describes media program in descriptions ranging 
from simple to detailed 

Web Info  provides URL information 
 provides download information 

Permissions  provides field to enter Distribution Agreement 
information 

 provides field to enter End User License Agreement 
information 

Build Options  generates PAD and signature PFX files 
 provides field for a password 

Affiliates  fields to enter download sites that can sign up to be 
affiliates of your products 

ASP 
(Association of 
Software 
Professionals) 

 field to enter membership number  
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Use PADGen to execute the following: 
 import an XML file in PADGen 
 view an XML file in PADGen 

Import an XML file to PADGen 
1. In the Menu Bar, select File and then Import PAD file. The tabs populate with the data 

from the PAD file.  

 

View an XML file in PADGen 
1. In the Main Screen, click Company Info tab. Review, verify or update company contact 

information. 
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2. In the Main Screen, click Program Info tab. 

 

Review and verify the following: 

 program that will run the XML file (in this case Flash Media Player) 
 version, release date, type and status 
 cost 
 install and uninstall 
 language of choice 
 size 
 category class 
 recent changes 
 system requirements 
 supported operating systems 
 expiration information 

3. In the Main Screen, click Descriptions tab.  
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4. Review the following descriptions: 

 Keywords 
 45-2,000 word character description 

5. In the Main Screen, click Web Info tab.  

 

Review or add the following URL information: 

 Application information and order 
 Screenshot 
 Program icon 
 PAD XML file 

Review or add the following download URL information: 

 Primary download 
 Secondary download 
 Additional DL URL #1 
 Additional DL URL #2 

6. In the Main Screen, click Permissions tab. Review or add the following information: 

 Distribution agreements 
 End-user License agreement 
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7. In the Main Screen, click Build Options tab. Review or insert PAD or PFX files to 
generate. 

 

 

8. In the Main Screen, click Affiliates tab. Enter information to allow download sites to 
affiliate with your company. 
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9. In the Main Screen, click the ASP tab. Click if you are a member, and then add a 
membership number. 
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Track Patient Information Using the ClinicPro 
Administrative System 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Overview 

Track patient information using the ClinicPro administrative system.  
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Track Patient Information Using the ClinicPro 
Administrative System 

Introduction 

Track patient information by entering basic information in the List tab. Here is a 
reference guide of the List tab of the ClinicPro software program:  
 Summary of ClinicPro List Tab 
Tab Option Function 
List Last Name Records patients’ last name 

First Name Records patients’ first name 
MI Records patients’ middle 

initial 
Patient No. Records patients’ “patient” 

number 
SSN Records patients’ social 

security number 
DOB Records patients’ date of birth 
Phone Records patients’ phone 

number 
Review patient information in the Patient Detail tab. Here is a reference guide of the 
Patient Detail tab of the ClinicPro software program:  

Summary of Patient Detail List Tab 
Tab Option Function 
Patient Detail Patient # Displays patients’:  

 last name 
 first name 
 middle initial 
 SS # 
 Date of birth 
 Gender 
 Marital status 

 Contact Information Displays patients’: 
 address 
 Phone, fax, cell 
 Email 

 Primary Dr. and Referring Dr.  Displays patients’ 
 Primary doctor 
 Referring doctor 

 Legal Information Displays patients’: 
 Lawyer 
 Responsible party 
 Legal representative 

 Job Information Displays patients’:  
 Employer 
 Job title 
 Status 
 Work number 
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Manage the Transactions Tab in ClinicPro 

The Transactions tab is a record of past payment transactions, and the section where you 
enter new transactions. This section describes how to complete the following: 

 search for completed transactions 
 check for Alerts 
 enter a new transaction 
 modify a new transaction 
 switch to different screens 

Search for Completed Transactions 
1. In the main window, use the down arrow to scroll through past transactions. 

  

Note: red lines show overdue accounts and blue lines 
show billed accounts. 

2. In the main window, select a line and click on it. The bottom left section of the screen 
gives a line item detail of the transaction. 

Check for Alerts 
1. In the main window, select a line, and click on it. The bottom right section of the screen 

gives alerts that need attention. 

Enter a New Transaction 

1. Click . Type in procedure number or choose it from the lookup list. Once you 
have chosen the procedure, the system automatically displays the fee and corresponding 
information. 
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Modify a New Transaction 

1. From the Transaction screen, click  to modify the transaction. 

2. Enter a procedure number or select from the list. 

 

Switch to Different Screens 
1. From the Transaction screen, click on each menu bar item to switch screens.  

 

 

Click On Switch To Information Screen 

2 Disability and Hospitalization 
I Insurance 
H HCFA 
C Chiropractic  
M Medical and Pediatric 
P Podiatry 
A Ambulance 

 


